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Formatting 
 

Excel has many formatting options. That can be a good thing and a bad thing. The large number of 

formatting options can make it harder to get the format you want. 

In most cases is pays to keep your formatting simple. Less is more. Formatting shouldn’t take the 

focus off the figures. Formatting can be used to make reports more readable and to make your files 

more useable. 

I will not be covering conditional formatting in this webinar as I have already presented a free 

webinar on conditional formatting. This is available on my website. 

Spelling 

Just a note on the word colour. I will be using the Australian spelling when talking about colours. Be 

aware that Excel options all use the US spelling of color. This applies to other Excel formatting 

options that use the US spelling eg center.  

  

Avoid Merge & Center 
 

 

This icon on the Home Ribbon tab should be avoided because it can cause two issues. The Merge & 

Centre format can stop you from copying and pasting ranges as well as causing macros to crash. 

There is an alternative format called Center Across Selection which achieves the same result without 

having the downsides. Unfortunately Center Across Selection does not have its own icon and it won’t 

work vertically, so Merge & Center is the only solution to merge a range vertically. 

 

 

Center Across Selection is in the Alignment tab of the Format Cell 

dialog. Use the Horizontal: drop down to access it. 

 

 

 

 

 

Colour Blindness 

Be aware that about 8% of men and 1% of women have some form of colour blindness. Red and 

Green is the most common form.  
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Keyboard Shortcuts 
Sometimes keyboard shortcuts can be the fastest way to apply formats.  

Ctrl Key 

The Ctrl key has a lot of selection shortcuts and when you combine these with its formatting 

shortcuts you can quickly select and format ranges just using the keyboard. 

The table below has a listing of useful Ctrl key formatting shortcuts.  

Ctrl +   + Shift Format Option 

1  Format Cells Dialog 

b  Bold 

u  Underline 

5  Strike Through 

! Shift Number - comma and 2 decimals 

# Shift Date   d-mmm-yyy 

$ Shift $ format - comma and 2 decimals 

% Shift % format - no decimal places 

& Shift Thin Outline Border 

_ Shift Remove Borders (underscore) 

 

The Ctrl key has a number of range selection shortcuts. 

Ctrl + * will select the current region - great for selecting tables 

Using the Shift key with Ctrl can also speed up selection by selecting ranges in batches.  

Ctrl + Shift + arrow keys - allow you to select ranges in each of the four directions  

Multiple Ranges 

The Ctrl key can also be used with the mouse to select multiple ranges in one go. This can speed up 

formatting. Select the first range as per normal and then hold the Ctrl key down and use the mouse 

to select other ranges. If you make a mistake you will need to start again.      

$ and % symbols 

When entering values into Excel you can use the $ or % symbols to automatically apply that format 

to the cell. 

F4 Function Key  

F4 repeats your last action. Note: it doesn’t repeat multiple actions, just the very last action. 

Alt + Enter 

If you want to force a line break within a cell use Alt+ Enter when typing the entry. This is slightly 

different to the Wrap Text format. Wrap Text will put a line break based on the column width. Alt + 

Enter forces the line break all the time. 
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Mouse Shortcuts 
The mouse offers many formatting shortcuts. Right clicking and right dragging can speed up a lot of 

your formatting work. 

Using the Quick Access Toolbar (QAT) can also allow you to have all of your common formatting 

icons just a click away. 

Format Painter 

 Double click this icon to allow for multiple pastes of the selected format. 

Right Click 

Right clicking a range or cell displays many of the common formats. 

 

When using the mouse it is important to use the correct mouse cursor. The two common cursors are 

the Fill Handle, and the arrow shaped cursor.  

The Fill Handle is used to fill between a start and an end point.  

The arrow shaped cursor is used to drag from one spot to another. 

Right Mouse Button Drag 

Both of these cursors can be dragged with the right mouse button. (This can take a little practice.) 

When you release the mouse button one of the options is to Paste Formats only. 

Fill Handle drag   

Warning: Dragging this cursor with the left mouse button is a 

Cut and Paste - be very careful it can cause #REF! errors. 
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Arrow cursor drag 

Borders 

 

The Borders icon drop down has a lot of options and each 

of the individual icons can be added to your QAT. 

 

I usually turn off gridlines on the sheet – View Ribbon, 

Show section. 

 

I frequently use the All Borders and the Thick Box Border 

format. 

 

  

The Draw Borders options allow you use the mouse to 

draw your borders directly on the grid.   

 

You can change the Line Color as well as the Line Style. 

 

 

 

 

Clearing Formats 

Sometimes you might just want to remove all the formats and start again. 

There is a Ribbon icon that clears all the formats.  

 

On the far right of the Home Ribbon tab in the Clear drop down is the Clear 

Formats icon.  

Another icon worth adding to your QAT. 
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Adding Icons to Your QAT 

 

It’s as easy as right clicking the icon and selecting  

Add to Quick Access Toolbar. 

 

 

 

To organise the icons on your QAT you need to customize it. Right click the QAT and choose 

Customize Quick Access Toolbar. 

   

The Separator icon (top) 

inserts a thin vertical line on 

the toolbar to separate 

sections. 

 

Use these arrows button to 

select an icon and move it up 

or down. 

Always click the OK button to 

keep your changes. 

 

 

 

Number Section Drop Down 

At the top of the Number section of the Home Ribbon tab is a drop down that 

contains many common useful number formats. 

 

Clicking the small arrow (bottom 

right corner) of a Ribbon section 

will open a dialog. 

In the case of the Home Ribbon 

the associated tab in the Format 

Cells dialog.  

  

Avoid using the Text format - it can 

cause issues with calculations. 
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Number Formats 
Obviously numbers are the reason Excel exists and using the right number format is important. Even 

if Excel doesn't have a standard format you can create a custom number format to suit your needs. 

Custom number formats have a large variety of different formats that you can use on your numbers. 

This includes how you handle zeros and negatives. Excel used to have a built-in format to display red 

brackets for negatives. Unfortunately it is no longer a standard format and you must create a custom 

number format to allow you to apply red brackets for negatives. 

 

The Custom option on the left 

allows you to use pre-defined 

custom formats or to create your 

own. 

You can select an existing custom 

format and modify it to suit. 

When you enter the format in the 

Type: box the Sample section shows 

what the selected cell will look like.    

 

 

 

Examples of Custom Number 

formats 

 

 

 

 

 

 

 

“Hide” values 

The last entry in the table shows the special custom number format which allows you to stop 

anything from displaying in a cell. This won't display on the sheet and it doesn't print out. This is 

slightly different to using the same Font Color and Fill Color.   

Note: When you link to another 

cell it will often use the format 

from the linked cell. 
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Styles 
Styles are a feature of Excel that have been improved in recent versions. Styles allow you to 

standardise your formats so that you can achieve consistent formats throughout your file.  

 

The advantage of using a Style to format a range is that changing the Style’s format will 

automatically flow through to all the ranges that have been formatted with that Style. This makes it 

incredibly easy to make changes that would otherwise be quite time consuming. 

Standardising your input cell colour is one 

way to make the user's experience better. If 

the user can easily identify the cells that 

they need to update it makes the input 

process smoother. 

Creating a standard input Style is a good 

idea. This does however involve usually 

creating three or four similar Styles to 

handle the different types of input that are 

common. For example you might have a 

dollar entry; a date entry; a percentage 

entry; and a number entry. These all might 

have the same fill colour but have separate 

number formats. Hence you may need to 

create a few different types of input Styles. 

This is reasonably straightforward as you can 

take an existing Style and modify it. 
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You can Modify an existing Style by right 

clicking the Style button and choosing Modify. 

You can also Duplicate it so that you can create 

another Style based on it whilst leaving the 

original Style unchanged.  

 

 

 

 

The tick boxes mean that a format on the relevant tab in 

the Format Cells dialog has been applied. 

Clicking on the Format button opens the Format Cells 

dialog. 

Most options are available. A few are disabled, mainly in 

the Border tab. 

 

 

 

 

 

 

Merging Styles 

You can use the Merge Styles option (bottom of the Styles Gallery) to copy Styles between files. You 

need both files open at the same time.  

WARNING: I have experienced frequent crashes when I use the Merge Styles option – save your files 

before using Merge Styles. 
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Using Colours 
 

Using Colours correctly in your spreadsheets can make the user's experience a lot easier. Using 

colours consistently throughout the file can make it easier to understand. 

Excel has a couple of features that use and recognise colours that you may not be aware of. 

 

Sort and Filter by Colour 

It is possible to filter and sort by colours.  

Filtering 

 

The right click menu shows the Filter 

options. 

   

 

The Cell’s Icon option refers to the 

icons available in conditional 

formatting 

 

 

 

Sorting 

Sorting by colour only sorts the chosen 

colour. Excel doesn’t sort all the 

colours because it has no way to figure 

out what order the colours should be 

sorted into. 

   

Sorting by colour also has an option for 

icons 
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Find by Colour 

Excel has a find and replace feature that has the ability to identify different colours in cells.  

Ctrl + f opens the Find and Replace dialog - Find tab.  

Ctrl + h open the Replace and Replace dialog - Replace tab   

Click the Options >> button 

 

 

 

 

 

 

The Format drop down 

allows you to choose a 

format from an existing cell 

or use the Format Cells dialog 

to define a format to search 

for. 

 

 

 

When you click the Choose Format from Cell option the cursor changes and you use 

the mouse to click on a cell. 

 

 

Clicking the Find All button 

identifies all the cells with the 

same format. 

Pressing Ctrl + a in the bottom 

section allows you to select all 

the cells matching the criteria.  

 

You could use this to clear 

inputs. 
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Formatting Functions 
One function that can perform formatting is the TEXT function. 

TEXT Function 

The function allows you to apply custom formats to cell values so that you can use them in headings. 

It converts the values into text. It is mainly used to convert dates into a usable format. Excel stores 

dates as numbers and you need to use the TEXT function to convert the date number into a common 

date format.   

Syntax 

=TEXT(Value,Format) 

Value - usually a cell reference to a value or date 

Format - format enclosed in quotation marks. 

TEXT Examples 

 

 

UPPER, LOWER and PROPER Functions 

These three functions convert text to their respective cases. See image below. 

 

To create headings you can use the & symbol to join text together. See examples below. 
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General Formatting Tips 
 

This final section is dedicated to all the other formatting tips that don't fit into the previous sections. 

It has a wide variety of different types of tips. 

Consider turning your gridlines off on your spreadsheets this can make your spreadsheets look 

cleaner. The gridlines on the spreadsheet are different to the gridlines on the print setup. They are 

controlled separately. Once you have turned off gridlines then you can apply your own borders to 

your sheets. 

The Alt key shortcut for sheet gridlines is Alt w v g pressed in sequence.  

On the Ribbon the sheet gridlines option is in two places (It’s one of the few options that’s in two 

places). One is in the Page Layout tab, the other is in the View tab.  

 

Format As Table 

The Format as Table icon on the Home Ribbon tab does a lot more than just apply a 

format.  

 

It adds special formats to the table including alternating row colours as well as different formats of 

the heading rows. I mention this to show you it exists and what it does - I have another free Data 

Handling webinar that covers many of the features that Format as Table incorporates. I highly 

recommend you use this feature for your tables in Excel. 

Handling Zeroes 

 

If you don't wish to display zeros on your spreadsheets then there is a setting that you can change to 

stop zeros displaying. The setting is in Options and it applies on a sheet by sheet basis.  

 

Alt f t opens the 

Options dialog or 

click the File Tab 

and Options button.  

Click the Advanced 

heading on the left 

scroll down about 

two thirds. 

Un-tick Show a zero in cells that have zero value and click OK.  

You can change the colour 

of the sheet gridlines 

using this option. 
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This shows what happens 

when you turn off 

displaying zeroes. 

Both calculated and 

entered zeroes do not 

display. 

 

If you need to only hide zeroes in a range you can use a custom number format to achieve that. See 

the see the custom number section earlier in the manual.  

Note: you can show zeroes as a dash using some custom number formats and the dash will still 

display if you have turned off zeroes. 

 

Formatting Charts 

 

Most people are unaware that you can use many of the formatting icons from the Home Ribbon to 

format charts. It is as simple as selecting a chart object and clicking on the relevant formatting icon. 

In many cases this is the quickest way to change the chart’s formatting. 

 

Not Pasting Formats 

 

In some cases to get the format right means NOT copying a format from one range to another. You 

might want to bring a formula from another range but you don’t want its format.  

 

The right click options offer a few ways to avoid 

formats.  

You can paste just Values  

just Formulas 

 Values and number formats 
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Luckily the Paste Special dialog has a few other 

options that can help you paste what you need. 

Alt h v s in sequence opens the Paste Special 

dialog. 

 

 

 

 

 

 

  

Freeze Panes 
 

If you want to keep some column headings at the top and rows headings on the left then use Freeze 

Pane in the View Menu 

It also has an Alt key shortcut 

Alt w f f pressed on sequence. 

 

 

 

Note: The Transpose option can be 

useful. It changes a row based range 

into a column based range. 


